Quick Start Avid
Purpose: This manual is designed to help users unfamiliar with the Avid editing
interface, Media Composer, to dive in and start cutting clips as quickly as possible.
While the manual is broad in scope, covering the major subjects needed to work
through an Avid project, it is not deep; only the most essential aspects of each topic will
be covered in the interest of quickly familiarizing the user with the Avid interface. It is
hoped that, upon working through this manual, the user will have enough understanding
of Avid’s basic functioning that he or she can independently dive deeper to discover the
more sophisticated features of the software.
Why Quick Start? There are many other introductions to Avid out there. What makes
Quick Start distinct is its paradoxical combination of brevity and comprehensiveness.
This unique combination gives you everything you need to get started and nothing
more.
Which Avid? This manual makes specific references to Avid Media Composer;
however, due to the similarities in programs, it should equally serve as an introduction
to (the now discontinued) Avid Xpress Pro.
Overview: Quick start covers the following topics:











Starting a project
The Avid interface
Capturing video
Editing
Audio
Effects
Titles
Finishing up
Backing up your work
Recommended Resources

Let’s get started!
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Starting a Project:
Open the Avid application. The “Select Project” window pops up:

The "User" field displays the user currently logged in to your computer.
The path selected in the "Folder" field determines which projects appear in the "Select a
Project" list below, and it will also determine where a new project will be created.
The three radio buttons (private, shared, and external) determine access settings to
your new project:




If you want your project to be available to only your personal log-in, select
"private."
If you want your project to be shared in the Avid shared folder (everyone who has
access to the computer's drive), select "shared."
If you want your project to be in a folder outside of the Avid private / shared
folders, choose "External" and set the path in the Folder field above.

After selecting the access option for your project, click the "New Project" button. A
"New Project" window opens.

Name your project and select the video format you'll be working in from the "Format"
drop down menu. Click "OK" and your new project is added to the "Select a Project" list
in the "Select Project" window. Double click the new project and it is launched.
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Which video format should I use? With all of the different formats out there, determining
the best format for your project can be tricky. The following list of format suggestions,
borrowed from Sam Kaufmann’s Avid Editing: A Guide for Beginning and Intermediate
Users, is useful:
Standard Definition:
NTSC is the standard definition video format used in North America, Central
America, Japan, Taiwan, the Caribbean, and parts of South America. If
you're working with NTSC, Avid offers three options:




23.976p NTSC: Canon XL2, Panasonic DVX100, or Panasonic DVX
900 and 24p "advanced" frame rate
24p NTSC: only for high-budget project, planning to finish on film
30i NTSC: Mini-DV or DVCAM, Beta SP cam, or DigiBeta at regular
30i setting; also for Canon XL2, Panasonic DVX100, Panasonic
DVX900 and 24p (not "advanced" frame rate)

PAL is the standard definition video format used in Europe, Africa, India, and
China. If you're working in PAL, Avid offers three options:




24p PAL: editing high-budget filim
25p PAL: Canon XL2, Panasonic DVX100, or DVX900 with 25p setting
25i PAL: DV or DVCAM, Beta SP, or DigiBeta cam

High Definition:
If you are shooting with high definition footage, select the appropriate
format (720p, 1080i/p) and a "raster type" that matches the kind of HD
you're working with (DVCPro, HD, HDV, etc.).
The Avid Interface:
Avid has four basic windows: the project window, the source monitor, the record
monitor, and the timeline. If you ever get lost in a sea of sub-menus, simply go up to
the "Tools" menu and choose "Source / Record." This will restore Avid's core layout.
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Project Window
The project window contains the raw material, settings, and tools you'll draw from to
create your edited video. Notice: the top of the project window tells you the name of the
project that you're working on. There are three key tabs in the Project window: the
"Bins" tab, the "Settings" tab, and the effects tab
.
The Bins tab holds all of your sequences (clips sliced and arranged in the timeline are
part of a sequence) and media clips (video files, music files, sound effects, still images,
etc.).
Inside the bins tab, you can create bins, or folders, that help you organize all of your
sequences and clips. Create new bins by going to the "File" menu and choosing "New
Bin." To rename a bin, simply click once on the bin name and type in the new name,
such as "Music files." To place a clip or sequence inside a bin, simply drag and drop.
The Settings tab contains innumerable settings for your project and for the Avid
program in general. When changing settings, it's always a good idea to create a user
profile. A user profile enables you to specify exactly how you want Avid to operate,
while enabling others to do the same when they sign in to the program. To create a
user profile, click on the drop down menu at the top of the settings tab and select
"Create User Profile." Type in the name of the profile and select "OK." Now, whenever
you change a setting from the list below, the settings will be assigned to your user
profile. I recommend creating a "default" user profile first and then creating an
additional user profile, so that when settings are modified, default settings can quickly
be restored.
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Let's try changing a setting. In the settings tab, scroll down to "Interface." You can
quickly change the look of the interface between "Classic," "Dark," "Light," and
"Medium" presets by clicking in the left column and creating a check mark next to your
choice. Suppose we want to do more. Select Interface / Dark, go to the "Edit" menu,
and choose "Duplicate." This duplicates the setting and now you have Interface /
Dark.1 below Interface / Dark. Click once on "Dark.1" to give this new interface preset a
unique name. Open this preset by double-clicking on its "Interface" listing. An Interface
window pops up. Select the appearance tab, and you can customize the colors of your
workspace.

The effects tab
in the project window is the effects tab, containing a variety of
visual effects to apply to your edits. We explore this tab in the "Effects" section.
Source Monitor
The source monitor is the intermediary between your bins and your timeline. To edit
clips, you double-click them from a bin to bring them into the source monitor. In the
source monitor, you can view and listen to your clips to choose exactly what portion of
the media you'd like to insert into the timeline (for how to do this, see the editing
section).
Record Monitor
The record monitor plays the material that's in your timeline.
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Timeline
The timeline is where your project comes together. Here, you add, trim, and rearrange
media to create your video project.
Capturing Video:
Unless you are working with a memory card or editing a pre-existing digital video file,
you will need to capture media from tape.
Before capturing
1. If this is your first time capturing, or first time capturing with a particular device,
you must configure your capture device (see below)
2. Always turn on the capture deck / camera before launching Avid -- otherwise the
capturing device will not be recognized!
3. While you can capture media on tape from a camera or a capture deck, it is
highly recommended that you use a capture deck. Capturing from a camera can
quickly wear down the camera's VCR.
4. Audio settings:




Go into the project window / settings tab and double-click "Audio"
choose "all tracks centered" if working with dialogue or narration
choose "alternation L / R" if working with music

Configuring your capture device





Go to the Project Window / Settings Tab / Deck Configuration
Click "Deck Configuration," go to the "Edit" menu and choose "Duplicate." This
creates a custom deck configuration, "Deck Configuration .1"
Click the ".1" and rename the deck configuration to describe your capture device
(e.g., "Sony DSR-11")
Double-click your custom deck configuration to open the settings
o click "Add Channel" and the software searches for the connection to the
capture device (e.g. "Firewire on OHCI")
o Avid will ask if you want to "auto-configure" the channel. Click "Yes."
o click "Add Deck" and the software searches for the capture device. Once
the device is found, click "OK."
o you should now have a deck configuration window that looks something
like this:

6

o
o

click "Apply" and the window will close
Make sure you select the deck configuration you have just created by
placing a check mark next to it in the settings tab.

Using the Capture Tool



In the project window, open the bin that you want the video clips to go into and
make sure all other bins are closed
Open the capture tool by going to the "Toolset" menu and choosing "Capture"

1. To capture media, make sure capture mode is toggled on:
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2. Select the tracks that you want to capture (usually V, A1, A2, and TC
[timecode]) (note: any video or audio tracks not selected for capture
will not be captured)
3. Select the video channel (if DV or HDV deck or camera, this should be
"Host-1394" [FireWire])
4. Select the audio channel (if DV or HDV deck or camera, this should be
"Host-1394" [FireWire])
5. Under "Bin," choose the bin you would like the captured media to enter;
make sure your selected bin is the only bin you have open
6. Select the capture resolution (if you're using a DV deck or camera, choose
DV 25; if you're using HDV, Avid automatically sets the correct resolution)
7. Next to the drive icon
media files to go:




, select a target drive where you'd like your

Avid does not allow you to create a sub folder for an individual
project's media. All media will go into an Avid-generated folder in
the root directory of your target drive
It is recommended that you capture media onto a drive different
from the drive that the Avid program is running from; this will keep
things running faster when it comes time to edit

8. Insert your tape into the deck or camera




a prompt asks you to name the tape (note: naming each tape
is extremely important; if Avid knows what tape clips were
captured from, clips can easily be recaptured if lost)
name the tape and click on the name to tell Avid which tape
you're using
click ok

Shuttling through the Tape
Unless you're capturing the whole tape, you're going to need to shuttle through your
tape to select the clips that you'd like to capture. To move through a tape, Avid has
VCR controls in the capture window. There are also keyboard shortcuts that enable you
to zip through video. With the capture tool open:



"J" rewinds the tape
"K" stops the tape
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"L" plays the tape
"spacebar" serves as a play / pause button
For tiny adjustments, the "←" and "→" keys nudge the tape one frame backward
and forward
pressing "J" or "L" more than once will increase the speed with which the tape
rewinds or plays.

Note: These same shuttle controls can be used to move through video in your source
monitor, record monitor, and timeline.
At last, you're ready to capture. There are three methods of capturing in Avid:
Capturing "on the fly," Capturing with "In and Out," and Batch Capturing.
Capturing on the Fly
Capturing on the Fly is the simplest method of capture. It is best for capturing large
chunks of media or entire tapes. The steps for capturing on the fly are:





With the tape in the capture device, press the red capture button. This will start
capturing from tape.
When you reach the end of the segment you want, press the red capture button
again.
Name the clip in the "Name" field.
A master clip appears in your bin once the capture is complete.

Capture with In and Out
When it comes to capturing one or more short clips from a tape, capturing with ins and
outs is a more precise and efficient method than capturing on the fly. The steps for
Capturing with In and Out are:










Navigate the tape to the point where you would like the captured clip to begin.
This is called the "In" point.
Mark the in point by pressing the
button on the capture window.
Navigate the tape to the point where you would like the captured clip to end. This
is called the "Out" point.
Mark the out point by pressing the
button on the capture window.
Name the clip in the "Name" field.
Press the red capture button. Avid automatically captures the media between
your "In" and "Out" point.
If necessary, abort the capture process by clicking on the
button next to the
red capture button at the top of the capture window.
A master clip appears in your bin once the capture is complete.
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Batch Capturing
For the majority of your projects, you'll find that batch capturing is the most efficient way
to work. You very quickly move through your tape and identify clips that you'd like to
capture (logging clips), then capture your selected clips all at once (batch capturing).
Here's how it works:
Logging clips:


Switch the log / capture button at the top of the capture tool to "log" mode:






Navigate the tape to where you want the clip to begin
Mark an in point by pressing the
button on the capture window
Navigate the tape to where you want the clip to end
Mark an out point by pressing the
button on the capture window
Name the clip in the "name" field




Press the
button and the clip is logged
Log another clip by repeating the steps above




Batch capturing:




Select all clips in your bin
Go to the "Clip" menu and choose "Batch Capture"
In the "Batch Capture" window, check the "offline media only" box:

Checking "offline media only" captures the clips that have been logged
and not captured (note: if the "offline media only" box is not checked, Avid
will attempt to capture every clip in your bin, including those that have
already been captured)


Click "OK" in the "Batch Capture" window, and Avid goes to work capturing
your logged clips
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Editing:
Editing in the Avid interface is not intuitive--that's why this "Quick Start" guide is as long
as it is. However, once you get used to it, you'll find that Avid editing is equally, if not
more, capable as any other non-linear editing system.
To edit clips in the timeline, there are four primary tools: splice / overwrite, lift / extract,
segment mode, and trim mode.
Splice / Overwrite
Splice / overwrite helps you get clips into the timeline. The splice / overwrite buttons are
located in the middle of the composer window, just below the source and record
monitors.

To work with splice / overwrite:











Double-click a clip in the bin to bring it into the source monitor
Set an "In" point in the source monitor by dragging the source monitor's playhead
to where you want the clip to begin and pressing the source monitor's
button
Set an "Out" point in the source monitor by dragging the source monitor's
playhead to where you want the clip to end and pressing the source monitor's
button
If you have clips in the timeline, move the playhead to where you want to insert
the clip from the source monitor (if you have no clips in the timeline, the clip will
be inserted at the beginning of your sequence)
Press the splice button
if you want to insert your clip into the timeline.
Splicing media into the timeline means that, like inserting a word into a
document, all material after the splice will be pushed forward
Press the overwrite button
if you want to put your clip into the timeline
and overwrite whatever media is already there. Overwriting media into the
timeline means that the new clip replaces any media underneath it

Video and Audio in the Timeline:


In Avid, video tracks are above the audio tracks in the timeline. Video tracks are
displayed as V1, V2, V3, etc.
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Audio tracks are below the video tracks in the timeline. Usually, a video clip
comes with two audio tracks (A1 and A2), representing the left and right channels
of a stereo pair.

Lift / Extract
Lift / Extract helps you take clips out of the timeline. The lift / extract buttons are located
at the top-center of the timeline.

To work with lift / extract:






Mark the beginning of the piece of media you want to remove by dragging the
timeline's playhead to the desired position and pressing the timeline's
button
Mark the end of the piece of media you want to remove by dragging the timeline's
playhead to the desired position and pressing the timeline's
button
Press the lift button
if you want to remove the media and leave blank filler in
its place.
Press the extract button
if you want to remove the media and delete the gap
where the media once was. Note: Be very careful when using extract. If you
have clips on multiple tracks, extracting media can shift things out of sync.

Segment Mode
Segment mode helps you move clips within the timeline. The segment buttons are
located at the bottom-left of the timeline.

To work with segment mode:





choose the yellow extract/splice-in segment button if you want a selected clip
to be extracted from one part of a sequence and inserted into another part.
choose the red lift/overwrite segment button if you want a selected clip to be
lifted from one part of a sequence and dropped into (not inserted) another part of
the sequence
with one of the segment tools selected, simply select a clip to move it. Note:
segment mode does not automatically select all layers of a clip. To select all
tracks of a clip (audio and video), shift-click the tracks to select them as a
group.

Trim Mode
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Trim mode helps you make fine adjustments to the edges of clips in a timeline. For
instance, suppose you have a clip in a timeline and discover that it's a few frames too
short. Do you have to go back and select new in and out points from the original clip?
No—trim mode enables you to add (or subtract) frames to a clip from inside the
timeline.
To work with trim mode:



In the timeline, drag the playhead over the edit point you want to work with.
Press "u." Pink bars appear around the edit point. You are now in "trim mode."



The composer window changes to a trim mode window. VCR controls appear,
enabling you to add to or subtract from the length of a clip.
o clicking the << button decreases the length of the clip by 10 frames
o clicking the < button decreases the length of the clip by 1 frame
o clicking the > button increases the length of the clip by 1 frame (if media is
available from the original clip)
o clicking the >> button increases the length of the clip by 10 frames (if
media is available from the original clip)
By default, when you enter trim mode, pink bars are on the end of one clip and
the beginning of another. This is called Dual-Roller Trim Mode and means that
modifications will be made to both the outgoing and incoming clip simultaneously.
To modify only the end of one clip or the beginning of another, you'll need to
activate Single-Roller Trim Mode:
o enter Dual-Roller Trim Mode and click on either the left or the right
monitor.
o The dual pink bars now change to a single pink bar on the end or
beginning of your clip in the timeline.
o Single-Roller Trim Mode is activated and you can modify the end or
beginning of a single clip.
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To exit trim mode: press "u" again.
Editing Tips:
Selecting tracks


The timeline tracks that your edits apply to are the record track symbols
highlighted on the left of your timeline (V1, A1, A2, etc.)



To select or deselect tracks that a timeline edit applies to, simply click on the
track symbol (e.g. V1)

Snapping—when selecting points to edit on the timeline, it can be helpful to "snap" the
playhead to the edges of a clip. To get the playhead to the edge of a clip, hold down
"Command" (CTRL on a PC) while dragging the playhead across the timeline.
Zooming in and out of the timeline:


To zoom into the timeline, drag the timeline playhead to the position you want to
zoom into and press the focus button at the bottom-left of the timeline.



To get a full perspective on all clips in your timeline, press "CMD + /" ("CTRL + /"
on a PC)
To zoom in and out of the timeline, use the zoom slider at the bottom-center of
the timeline
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Subclipping—you might have a long clip that you'd like to split into several shorter clips.
This is called subclipping:




Double-click a clip from a bin to place it in the source monitor
In the source monitor, set an in and out point
Drag the image from the source monitor back into the bin and you will have a new
sub clip

Adding filler—"filler" is Avid's term for blank video. Blank video is particularly useful to
add at the beginning and end of your projects.



To add filler to the beginning of your project, go to the "Clip" Menu and
choose "Add Filler at Start"
To add filler to the end or anywhere else on the timeline, click the "clipname" menu in the Source Monitor and choose "load filler." Then, insert
the filler from the source monitor into the timeline.

Timecode—it is helpful to start your sequence's timecode at 01:00:00, but Avid does not
do this by default. To reset your timeline's timecode:




select your sequence in its bin
choose the bin's "text" tab and scroll over to the "start" column
click on the start value and set it to "01.00.00.00"

Audio:
It is important to adjust the audio levels of your project so that, when you upload it to
Youtube, play it on a television from a DVD, or enter it into a film festival, your audience
can hear everything without having their ears blown out.
Three tools are key in mastering your audio: the audio tool, the audio mixer, and the
auto gain.
Audio Tool
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The audio tool is a meter that tells you the audio levels of your project.
Access the audio tool by going to the “Tools” menu and choosing “Audio
Tool.”
Play through clips on your timeline. The audio tool shows the audio levels of
your clips.
Refer to the read out on the left inside the audio tool (digital scale). Many
production companies use -20db as their target audio level, meaning you
want the levels of your primary tracks (often dialogue tracks) to fluctuate
around -20db. Do not worry about setting your levels to exactly -20db; as
long as they are within a 5db range (-25db to -15db) most of the time, your
audio will sound normal.
Background music and sound effects can go as low as -40db, and loud
sounds can go up to -4db. Experiment with what sounds right to you.

The audio tool tells me my levels are good, but the volume sounds way too loud /
soft to me. This is most likely because your computer volume is too high / low. To
adjust the computer volume to match the audio output:




Go to Project Window / Settings and double-click the "Audio Project" setting
Select the "Output" tab
Make sure "output gain" is set to 0 and drag the "monitors" volume up or
down to match the 0-level of the output gain.

Audio Mixer
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The audio mixer is a tool that enables you to raise and lower the levels on
your tracks.
After determining if a level needs to be raised or lowered with the audio tool,
open the audio mixer by going to the "Tools" menu and choosing "Audio
Mixer."
To raise or lower the audio levels on one clip:
o
o
o



To change multiple tracks at once:
o
o
o

o



In the timeline, move the playhead over the clip that you want to
change.
In the audio mixer, make sure the track(s) that you want to change
(A1, A2, etc.) is selected.
Adjust the track's volume slider up or down.

In the timeline, move the playhead over the clip that you want to
change.
Make sure the tracks (A1, A2, etc.) are selected in the audio mixer
Press the gang button for each track you'd like to link

Adjust the volume slider on one of the tracks up or down and the
sliders on multiple tracks change together

To set levels for all clips on a track:
o In the timeline, move the playhead over a clip on the track you want
to change.
o In the audio mixer, make sure the track that you want to change
(A1, A2, etc.) is selected.
o Adjust the track's volume slider to the desired level
o In the Audio Mixer's fast menu, choose "set level on track - global"
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o All clips on the track are now adjusted
Auto Gain
Auto gain is a mode that enables you to place dots, or key frames, on your audio
tracks to make fine audio adjustments. Set key frames to make fine adjustments
after you have used the Audio Mixer to make broad-scale adjustments to your
audio levels.


To turn on "auto gain," go to the timeline fast menu, select "Audio Data," then
"Auto Gain"



To use auto gain:
o

o
o
o

Make sure the audio track on which you want to add a key frame is
highlighted in the list of record tracks (A1, A2, etc.) on the left of the
timeline (if other audio tracks are highlighted, key frames will be
added to them as well)
If you want to add a key frame to multiple audio tracks at once, make
sure all tracks are highlighted in the list of record tracks
Move the playhead to the exact place on the timeline on which you
want to add a key frame
Press the [ " ] key to set a key frame.
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o

Set another key frame before or after the point where you set your
first key frame, and you will be able to drag the key frames up or
down to change the audio levels over time.

o

To move a key frame to the left or right, option-click (MAC) or altclick (PC) and drag it across the timeline
To delete a key frame, mouse over it until the pointer turns into a
hand symbol; then, press "delete"

o

Effects:
Avid has effects that can be applied to a whole clip or effects that are only for
transitioning between clips. This guide shows you how to apply a transition effect and
edit some of its properties; with this knowledge, you should be able to explore the many
other effects on your own.
To apply a transition effect:






In the project window, choose the effects tab
. This brings up a menu of
Avid's many effects.
In the effects menu, choose "Blend" in the left column, and "Dissolve" in the right
column to select a standard dissolve transition.
Drag the "Dissolve" transition straight from the effect menu onto a video edit
point (where one clip ends and another begins) in the timeline
If an "Insufficient Source" window pops up, click "size to fit" and the transition is
applied
Make sure that the video track onto which you want to apply the transition is
selected in the list of record tracks (V1, A1, A2, etc.) at the left of the timeline; if
you attempt to apply a transition to a track that is not selected, nothing will
happen
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Once the transition is applied, you can watch it in the record monitor.
To edit the duration of the transition:
o move the playhead over the transition
o select the "effects mode" button
at the upper left of the timeline and
the effects window pops up (the effects window enables you to change the
variables of any effect)
o the duration of the transition is listed in the bottom of the effects mode; to
change the duration, simply click the listed duration and change it
(remember, 30 frames = one second; so, a 15-frame transition is half a
second, and a 5-frame transition is one-sixth of a second)

Rendering
When effects appear in the timeline, they have a green dot on them, meaning they are
"unrendered." "Unrendered" means that the computer needs some time to process
them. More complex effects may not play properly in the record monitor if you leave
them unrendered. To render an effect:





In the timeline, move the playhead over the effect.
Make sure that the video track containing the effect is selected in the list of
record tracks (V1, A1, A2, etc.) on the left of the timeline.
Click the render effect button
at the top of the timeline.
A "Render Effect" window pops up; click "OK," and the effect is rendered.

Deleting an Effect




In the timeline, move the playhead over the effect.
Make sure that the video or audio track containing the effect is selected in the list
of record tracks (V1, A1, A2, etc.) on the left of the timeline.
Press the "Remove Effect" button
at the top of the timeline.

Titles:
The title tool in Avid is a powerful and easy way to create titles. To create a title:


Select the "Title Tool" from the "Tools" menu. The Title Tool appears.
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The Title Tool automatically puts whatever video image your playhead was
positioned at in the timeline in the Title Tool. This does not mean your title will be
connected to this image. It means only that your title will be able to be layered
on top of video or a graphic. If you do not want your title to be layered on top of
video or a graphic, and you prefer that your title is over a black screen, deselect
the "V" button at the bottom of the Title Tool.
Avid has made creating your title very intutive--it's almost like using a paint
program. You can add text with the "T" tool, easily change the font and font
attributes at the bottom of the window, and position text with the arrow tool.
Adding shapes: rectangles, ellipses, and lines are also available at the bottom of
the Title Tool Window. Note: If you'd like to add shapes under text, you must
create a shape, select it with the arrow tool, go to the "Object" menu, and choose
"send to back."
Once you have the title looking the way you want it, go up to the "File" menu, and
choose "Save Title." A Save Title window pops up. Name your title and click
"save." The title is now available as a clip in your bin.

Title Safe: Televisions and projectors come in many dimensions; some show more
video on the screen than others. How, then, can you be sure that the full text of your
title will appear on all screens? Avid has a white box in the Title Tool window called
"Title Safe" to help you. Make sure your all of your titles fall within the innermost white
box of the Title Tool window. This way, you can be sure your titles will be seen on all
screens.
Finishing up:
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Once you've completed your edit in Avid, you'll want to export your project to make it a
stand-alone video. You can then take this video and put it onto a DVD, upload it to
Youtube, put it on a web site, or share it however you want.
Before you export







Duplicate your main sequence. Select the sequence in your bin, then go to the
"Edit" menu and choose "Duplicate." Now you can export a duplicate copy of
your sequence without worrying about any freak export accident harming your
original sequence.
Save all of your bins by going to the "File" menu and choosing "Save Bin"
Make sure the video track monitor on the list of record tracks at the left of your
timeline is at the highest level of video; otherwise all video tracks will not be
exported.

If you only want to export a portion of your sequence, set "In" and "Out" points on
the timeline and only the video from the "In" to the "Out" point will be exported.

Exporting (there are many ways to export; this tutorial walks you through creating a
high-quality QuickTime movie file)








Go to the "File" menu and choose "Export." An "Export As..." window pops up.
In the "Export Setting" area at the bottom of the "Export As..." window, choose
"Fast-Export QuickTime NTSC/PAL"
Choose "Options" in the "Export Setting" area. An "Export Settings" window
pops up.
In the "Export Settings" window, make sure export as "QuickTime Movie" is
selected. Then click "Same as Source." This will export your video in the
highest resolution possible (the same resolution in which your media was
captured); click "Save."
Back in the "Export As..." window, name your project in the "Save As" field,
choose the location where you would like the file to be saved, and click "Save."
Your project is exported.

Backing up Your Work:
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Editing programs, including Avid, can and do crash. To prevent devastation and stressrelated hair loss, you will want to back up your project file at least once per day.
To back up your Avid project file:


Locate your project file folder on your computer (the path to your most recent
project is listed in the "Folder" field of the "Select Project" window when Avid first
opens)



Copy the project file folder onto a backup drive (flash drives work well for this
purpose)

The Avid Attic
Avid has an "attic," or auto-save vault, that automatically backs up versions of your
project file. The attic should not be used in place of daily project file back up to an
external drive because if your hard drive fails, your "attic" will be wiped out with it. Still,
the attic can come in handy if your computer crashes and you need to quickly restore a
current version of your project file.
You can change how often the attic saves your project file (and other attic settings) in
the "Bin Settings" menu. To find "Bin Settings," click on the settings tab in the project
window and double-click "Bin."
NOTE: backing up your project file folder only backs up your Avid project (bins, timeline
edits) and does not back up any of the media files within your project. The project file is
only a shell, skeleton, or recipe for what your finished piece will ultimately look like. The
meat of your project file comes from the media.
If your media is somehow lost or destroyed and you have it on tape, you can recover it
by batch capture (see batch capture in the capturing video section). However, this
takes some time. It is best to back up all of your media immediately after you capture it
onto a hard drive (you only have to do this once, as captured media files never change
as you work through a project).
Avid creates a media files folder (called "Avid MediaFiles") on whichever drive is set to
receive captured media. Once you have captured all the media for your project, back
up the Avid MediaFiles folder to an external drive to ensure that your project is secure
and easily recoverable in the event of an accident.
Recommended Resources:


Sam Kauffmann’s Avid Editing: A Guide for Beginning and Intermediate Users
provides a comprehensive, easy-to-follow introduction to Avid editing software
(this guide owes a lot to Kauffman's book)
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Avid created a series of free video tutorials for Avid Xpress Pro at
(http://learn.avid.com/content/tutorials/). While Avid Xpress Pro has been
discontinued, its interface is similar to Media Composer.
The Avid Community (http://community.avid.com/) is a forum for Avid users
featuring video tutorials and expert users on hand ready to answer your
questions
Lynda.com is an excellent and economical site offering video tutorials on Avid
and nearly any other software application you could want to learn
Walter Murch’s In the Blink of an Eye: A Perspective in Film Editing provides
excellent insight into the art of editing from one of the luminaries of the editing
industry
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Thank you.
Thank you for using Quick Start Avid. I hope this guide was useful for you.

About Quick Start: Quick Start Avid was produced under the auspices of an
independent study at the University of Colorado, Denver. The project was supervised
by Professor Marty Otañez, June, 2010.

About the Author: Alan August is a writer, filmmaker, and digital artist residing in
Denver, Colorado. His creative work has been featured in Newsweek, the Washington
Post, and the Getty Museum. Recently, he served as a writer on the Food Network
Show, Unwrapped. Alan earned his B.A. in Communication from the University of
Colorado, Denver, in 2010.

Comments or suggestions for the author? Send me an e-mail at
telesterionfilm@gmail.com

This guide is licensed under the Creative Commons. Please distribute it freely.
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